
 

1 

   

February 27, 2008 
 

Welcome to the Family Tree Maker Users Group! 

Powerful genealogy information management, easy-to-use research tools, and creative output options 
make Family Tree Maker the most complete resource for building your family tree.  

Tonight’s Agenda: Review FTM 2005/2006/v16 Basic Features 

1. Using the Tools Menu features 

2. Using the Internet Menu features 

3. Entering information from the Internet 

Most of these features will work in earlier versions of FTM. Most of the FTM 2005/2006 features are 
Internet and publishing related. 

Using the Tools Menu 

Selecting the ‘Spell Check All’ feature is for a quick dictionary spell check of all text items in your 
family file. This includes the Family View, Trees, or Reports including your notes section. Basically, it 
works identical to any spell checking program in a word processor. It has a resident dictionary that is 
customizable by adding more of your words to the dictionary. Make sure you let the spellchecker finish 
checking the entire area before closing it, otherwise, your changes will not be saved. 
 
You can do more custom features with spell checker, ie, capitalization, words with numbers, and known 
names. Select File, Preferences, Editing, Spell Check to change the customized preferences. 
 
Selecting the ‘Find Error’ feature helps to find and eliminate possible errors in names and unlikely birth, 
death, and marriage dates. Error in names includes extra characters, ie, dashes, illegal characters, titles in 
name area, ie, Dr., Rev., Senator, Capt., etc. married name instead of maiden name, and nicknames, ie, 
Jim instead of James, John or Jon instead of Jonathon. Also too few or too many capital letters will 
indicate an error. 
 
Errors in birth, death, and marriage dates will alert you to the wrong dates and asks you for a correction. 
An Error dialog box appears when errors exist. This feature (2005/2006/v16 versions only) allows you to 
manually correct the error, ignore the possible error, auto-fix the error, which undo and replaces the 
original information if applicable, and move on to next error by selecting ‘Find Next.’ If you don’t fix the 
error before moving to next error, it will remain as an error. 
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Selecting the ‘Relationship Calculator’ automatically calculates the relationship between the selected 
individual and his or her spouse, child, father, or mother for either civil and Canon law marriages. Civil 
law is when two individuals are married by law whereas Canon law measures the next steps from a 
common ancestor in degrees, ie, you and a first cousin through a common grandparent would be 2 steps 
or second degree removed. 
 
You can make changes to nay individual to find their relationship by selecting the ‘Change’ button, which 
directs you to the index. Select the new individual to find another relationship. 
 
Selecting the ‘Soundex Calculator’ is a great feature to use. Soundex is a method of coding names with 
unique numbers based on the way the names sound — not on their spelling. By grouping together last 
names that sound similar (such as Story, Storey, and Storie: Soundex code S360), Soundex allows people 
to search for ancestors, even when the surname may have been recorded in any of several different 
spellings. However there are some limitations to be aware of when using Soundex, such as misspelling of 
names. Instead of Story, the name could be spelled as Tory, Torey, Torie, etc., (Soundex code T600), 
which confuses you with the wrong Soundex coding and possibly lead you down the wrong, or possibly 
even a better path. 
 

 
 
It works identical to the Soundex calculator in the 1880 to 1920 Census report indexes and most 
subscription databases. Nice to know, but works automatically using Ancestry.com. 
 
Selecting the ‘Date Calculator’ will calculate an individuals’ birth date, an individual’s age at the time of 
an event, or the date of an event. You need two of the dates to calculate the third date. Imagine you find a 
tombstone or death record that says: Died March 15, 1886, Age 52 yrs 6 mos 5 days Using the calculator 
will find his birth date, assuming the information is correct. The calculator can also find any individual’s 
age depending on the event and knowing their birth date. 

If the Date Calculator detects that there is more than one possible correct answer to your calculation, it 
will display a warning at the bottom of the dialog box. In practical terms, this means that the tombstone or 
other record may contain a miscalculation, and you will need to check your data against another source. 

Selecting ‘Family File Statistics’ provides information on how many individuals, generations, surnames, 
and file s size are in this particular file. The statistics will also indicate number of marriages, average 
lifespan, and earliest birth date known, for all listed birthdates. 

Selecting “User Information’ provides important source information when sharing with other relatives or 
friends. It can be used for Internet searches as explained later. You can always update this file when 
information changes, ie, address or telephone changes, etc. 
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Selecting ‘Compacting Family Files’ reduces your file size. It’s recommended if your file size is larger 
than a backup media, ie, CD (750Mb) or floppy disks  (1.44Mb). If you remove pictures in a scrapbook, 
the size of the Family File is not automatically reduced and should be compacted to reduce the file size.  
 
A dialog box appears after selecting this feature, which asks you to backup the file. This is highly 
recommended as sometimes compacting can alter some files. 
 
Selecting ‘Map Location Check’ allows a map to show most individuals on their birth or death locations 
as instructed. FTM eliminates any overlapping on a map to avoid confusion. If overlapping is preferred, 
modifications can be made to show the overlapping of locations. From the contents menu, select the 
options and select label all locations to show the overlapping. 

 

Using the Internet Menu 
 
Selecting ‘Create You Family Home Page, Update or Edit My Home Page, Add a Tree Report to 
My Home Page, Add a Picture to My Home Page, and View My Home Page’ allows users to start 
their own web page on the Internet to share ancestor data with relatives and friends on the same family 
lines. If you’re interested, read more information about these features in the HELP Menu.  
 
Be aware there is a charge with some subscription services. Websites can be password protected.  
 
Selecting ‘Start A Ancestry.Com Trial Subscription’ allows users to use the Ancestry.com for a trial 
period of two weeks. Only selected databases are allowed on a trial period. You must cancel out before 
the two weeks to avoid any charges to your credit card. 
 
Selecting ‘Purchase A Ancestry.Com Subscription’ allows users to use the Ancestry.com database. 
There are different databases and packages. They offer both monthly and annual rate packages. A 
suggestion is to use the monthly service if you’re not going to use the service every week or month. You 
can always use the FREE Ancestry.com database service at the Fort Collins or the Loveland Libraries. 
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Interestingly, Ancestry.com is offering different rates for the U.S. and World Deluxe subscriptions. 
If you can afford it, use the annual rate as it’s less expensive. Please order new subscriptions through 
our society website and select Ancestry’s logo. All prices are the same through our website. 
 

 
 
 

Selecting ‘Contribute to World Tree Collections’ allows the users to send their family file information 
to Ancestry.com and Genealogy.com for others to use. However, if you’re not a paid member to either of 
these services, you won’t be able to access these collections. You can access the non-paid tree collections 
instead, which is highly recommended. The database subscription companies are making money off your 
family trees in the World Tree Collections. 
 
The non-paid subscriptions include Ancestry Family Tree, Rootsweb Trees, and Family Home pages in 
Genealogy.com for you to create or edit your family trees for others to use. Also another important feature 
of these three services are the surname message boards. Each service has their own surname or location 
specific message boards. You can join a mailing list that notifies any user of new emails from these 
surnames message boards through Rootsweb. 
 
Selecting ‘Online Resources’ links you to the Family Tree Maker website. It gives you an overview of 
FTM Version 16 software features, What’s New in features since the last version, World Tree Collections 
(see above for detail), a Help Center (if you’re stuck) with FREE tutorials (basically same as internal Help 
menu), paid training classes, downloads for FREE updates, and email or telephone support, and 
Frequently Asked Questions on FTM features. Also accesses FTM User Forum for outside help from 
other users. 
 
Selecting ‘Ancestry.com’ links you to your subscription at Ancestry.com, if applicable. 
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Entering information from the Internet 
 
FTM 2005/2006/v16 has several new features over previous versions in using the Internet. A connection 
to the Internet is required to use these features. It’s preferable to have a cable or DSL broadband modem 
to access these features, due to the increased speed to access the census, military records, newspapers, and 
vital statistics. 
 
If you have access to Ancestry’s subscription, users can automatically connect to this database service by 
registering this product. Select ‘Register Family Tree Maker from the Help menu and follow instructions. 
You’ll need your password for accessing your database. 
 
FTM2005 has only the Web Search Results whereas FTM2006/v16 has four components of Web Search. 
Earlier versions of FTM don’t have any of these built-in features, but will show you below how to use the 
same features. 
 
Great Feature Alert: Selecting the ‘Web Search Results’ submenu button in the Family View screen 
below each ancestor will access Ancestry’s database. This feature shows matches in a Web Search Results 
window as shown below. The quality of the matches range from one star (lowest possible match) to five 
stars (exact match). You can review the matches to determine if any relationship exists. You can receive 
up to hundreds of matches, which may or may not apply depending on the multiple star rating. 
 
FTM has a great search engine for locating ancestors, sometimes even better than the subscription 
services. I use the FTM search engine besides Ancestry and GenSmart’s search engine to locate hard to 
find ancestors. 
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This window above consists of three panels. The upper, main panel displays the records found in order of 
descending quality. The upper panel includes the star rating for each record (more about this later) as well 
as the individual's name, the database the record came from, and other information. 
 
The lower left panel displays the specific data from the selected record that will be merged into your 
Family File if you chose to accept it. The lower right panel displays the data currently in your file for the 
selected individual. 
 
Usually five stars is a positive match, whereas all others could be. One to three star matches are unlikely a 
match, but if you don’t have many matches, check on these as spelling errors, location issues, or date 
issues could be incorrect.  
 
Users can change the default [1] ‘Quality’ setting to a lower amount of stars, then select [2] ‘Search’ 
button as shown by the numbered boxes above. Start with four or five stars and work down. 
 
You can narrow the search results by selecting specific [3] Categories. Usually you can eliminate about 
one fourth to one tenth of the results by selecting a specific category. 

After you review each item in the box, you can [4] ‘View Online,’ [5] ‘Merge,’ or ‘Merge to Others’ 
regarding the information for that particular individual. Viewing online shows the information in a 
document of which you can view the document image (ie, census report). If it looks satisfactory, then I 
would recommend saving the image to your computer in a ‘Genealogy Documents’ folder by surname 
subfolders. Remember our last class for saving these images into a source citation for the affected 
ancestor.   

However, be careful not to ‘Merge’ anyone without thoroughly checking the information. In some cases, 
you may already have that item in your tree. Merging can also be done for the limited source information. 
Users can select ‘Merge to Others’ to save the database information to other individuals via an ‘Index of 
Individuals’ list. 
 
Great Feature Alert: With the [6] ‘Edit’ icon (pencil graphic), users can add text notes directly to the 
General, Facts, or Notes sections for the individual, if you prefer not to merge any information. 

For earlier versions of FTM or other similar genealogy software: You can access any genealogy database 
and supply the ancestors name and dates. Most databases will allow you to save the information into your 
documents folder or memory stick. The ancestor results will be similar to the results shown above. 

FTM2006/v16: Selecting ‘Family Facts’ in the same Web Search submenu gives you pertinent 
information on surnames origination and meanings. Selecting ‘Research Tips’ gives you additional 
information on other research tips in locating your ancestors.  
 
For users with earlier versions of FTM: Access Ancestry.com’s Learning Center page directly and select 
‘Family Facts’ about your surname or ‘Ancestry Library’ for how to research articles. 
 
FTM2006/v16: Selecting ‘Contact Other Researchers’ allow you to contact other Ancestry members 
(possibly cousins), who are researching your ancestors via an internal message board. If any other 
researcher sees your message, they’ll contact you via email. I’ve used this feature successfully in finding 
other researchers and cousins. These web search services are auto linked to Ancestry’s Connection 
Services. 
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For users with earlier versions of FTM: You can access the same feature by accessing the Ancestry.com’s 
Home page directly, then select ‘Ancestry Community’ tab at top, then search for other researchers or 
distant cousins using the Message Boards by typing in the surname, or select Ancestry’s Connection 
Service to find other possible researchers. 
 
There are other message boards to access with Rootsweb.com and Genealogy.com for both surnames and 
locations. 
 

Reminder on Backing Up Files  

Don’t forget to backup your critical family tree files. Periodically, backup your family files to a CD and 
send to a family member, or worse case, Ancestery.com now offers Internet backup (six months FREE) 
for $20 annually thereafter for FTM2006/v16 users. FTM2006 links you to their service automatically 
when selecting Backup option in the File Menu. 

 

Tonight’s Agenda Review 

1. Using the Tools Menu features 

2. Using the Internet Menu features 

3. Entering information into  

If you’re new to FTM or other software, your assignment is to review these and the past features of FTM 
and continue adding more names into your family file. 

Our next class on April 5 will be held at the Loveland Library. I will discuss Intermediate features on 
adding pictures to the scrapbook for later use in books, charts, trees, and reports. We’ll show how to scan 
for pictures, retrieve them from the Internet or email attachments as discussed in March’s program, 
modifying picture quality, and adding captions to pictures. 

See you on March 31 for our April meeting and bring a guest! An email will be sent 

in late March notifying you of the date and location of the April (March 31) class.  
 
If you want the latest Version 16 software, please purchase through our society affiliate, Amazon.com for 
$27 plus shipping. Type in Family Tree Maker in the Amazon text box, then select the FTM V16 package 
as the society receives credit. Please order through our society website and enter Family Tree Maker in 
the Amazon.com’s search field. 


